
[bookmark: OLE_LINK3][bookmark: OLE_LINK4]TOBB EKONOMİ VE TEKNOLOJİ ÜNİVERSİTESİ
FEN BİLİMLERİ ENSTİTÜSÜ





TEZ BAŞLIĞI 
(TEZ BAŞLIĞI EN FAZLA 
3 SATIR OLMALIDIR)




YÜKSEK LİSANS/DOKTORA TEZİ

İsim SOYİSİM


Bölüm İsmi Anabilim Dalı

Tez Danışmanı: Ünvan İsim SOYİSİM

AY(yazı ile) YIL(rakam ile) (SAVUNULAN ZAMAN)


Çift numaralı sayfalar boş bırakıldığında, bu sayfalara sayfa numarası verilmemelidir. Bu uygulamanın sağlanabilmesi için aşağıdaki basamaklar izlenmelidir:
Section Break (Bölüm Sonu) Kullanarak
1. Gizlemek istediğin sayfanın öncesine git
2. Layout (Düzen) sekmesinden Breaks (Sonlandırmalar)
3. Next Page (Sonraki Sayfa) seç.
4. Gizlemek istediğin sayfanın sonuna git 
5. Tekrar aynı şekilde Next Page Section Break ekle.
(Böylece o sayfa tek başına bir bölüm olur.)
6. O sayfadayken üst/alt bilgi alanına çift tıkla.
7. Header & Footer Tools → Link to Previous seçeneğinin işaretini kaldır.
8. Sadece o bölümdeki sayfa numarasını sil.
Böylece sadece o sayfada görünmez, diğer sayfalarda numaralandırma devam eder.
		




ii



Fen Bilimleri Enstitüsü Onayı
………………………..
Prof. Dr. Burak BİRGÖREN
Müdür

Bu tezin Yüksek Lisans derecesinin tüm gereksininlerini sağladığını onaylarım.

……………………….
Unvan İsim SOYİSİM
Anabilim Dalı BaşkanıTOBB ETÜ, Fen Bilimleri Enstitüsü’nün Öğrenci Numarası numaralı Yüksek Lisans Öğrencisi İsim SOYİSİM‘in ilgili yönetmeliklerin belirlediği gerekli tüm şartları yerine getirdikten sonra hazırladığı “TEZ BAŞLIĞI” başlıklı tezi Gün(rakam ile) Ay(yazı ile) Yıl(rakam ile) (Savunma günü yazılmalı) tarihinde aşağıda imzaları olan jüri tarafından kabul edilmiştir.





Jüri Üyeleri :		Ünvan İsim SOYİSİM (Başkan)	   	  ..............................
Üniversite İsmi
Ünvan İsim SOYİSİM			  .............................
Üniversite İsmi
Ünvan İsim SOYİSİM		 	  .............................
Üniversite İsmi


Tez Danışmanı : 	Ünvan İsim SOYİSİM		              ..............................
	TOBB Ekonomi ve Teknoloji Üniversitesi	
Eş Danışman:	Ünvan İsim SOYİSİM		              ..............................
(Varsa)	TOBB Ekonomi ve Teknoloji Üniversitesi	


i


ii







TEZ BİLDİRİMİ
Tez içindeki bütün bilgilerin etik davranış ve akademik kurallar çerçevesinde elde edilerek sunulduğunu, alıntı yapılan kaynaklara eksiksiz atıf yapıldığını, referansların tam olarak belirtildiğini ve ayrıca bu tezin TOBB ETÜ Fen Bilimleri Enstitüsü tez yazım kurallarına uygun olarak hazırlandığını bildiririm.
İsim SOYİSİM
(Buraya imza atılmalıdır)
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[bookmark: _Toc207281085]ÖZET
Yüksek Lisans/Doktora Tezi
TEZ BAŞLIĞI
İsim SOYİSİM

TOBB Ekonomi ve Teknoloji Üniveritesi
Fen Bilimleri Enstitüsü
Bölüm İsmi Anabilim Dalı

Danışman: Ünvan İsim SOYİSİM
Tarih: Ay(yazı ile) Yıl(rakam ile)
Tezinizin özetini buraya yazınız.(Tüm tez boyunca metinler sayfada iki tarafa yaslı olarak yazılmalıdır.)
Anahtar Kelimeler: Anahtar kelimelerde her kelime/kelime öbeği için ilk kelimenin ilk harfi büyük harf, ikinci kelimesi varsa küçük harf olarak yazılmalıdır. Örnek: Üretim teknolojisi, Sayısal çözümleme, Makine öğrenmesi, İlaç sistemleri, …
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[bookmark: _Toc207281086]ABSTRACT 
Master of Science/Doctor of Philosophy

THESIS TITLE
Name SURNAME

TOBB University of Economics and Technology
Institute of Natural and Applied Sciences
Department Name Science Programme

Supervisor: Title Name SURNAME
Date: Month(in words) Year(in numbers)
[bookmark: _Hlk139917626]Write the abstract of your thesis here. (The text should be formatted as justified.)
Keywords: For each keyword/phrase, the first letter of the first word should be capitalized, and the second word, if any, should be lowercase. Example: Production technology, Numerical analysis, Machine learning, Drug systems, …
ÖNEMLİ NOT: Bu kısım, Türkçe olarka yazılmış olan “ÖZET”in birebir aynısı olarak çeviri yapılarak yazılmalıdır.
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[bookmark: _Toc207281087]TEŞEKKÜR
Teşekkür bölümünde resmi ve akademik üsluba uygun bir metin yazılmalı; samimi fakat laubali ifadelerden kaçınılmalıdır. Ayrıca, öğrencinin üniversiteden burs alması durumunda, üniversitenin adı belirtilerek teşekkür edilmesi gerekmektedir. 
ÖNEMLİ NOT: Bu kısımda satır arası boşluk 1 olarak ayarlanabilir. Metin yine iki tarafa yaslı olarak verilmelidir.
[bookmark: _Toc286759105]
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[bookmark: _Toc207281088]İÇİNDEKİLER (Tez tamamlandığında bu liste güncellenmeli)
Sayfa
ÖZET	v
ABSTRACT	vii
TEŞEKKÜR	ix
İÇİNDEKİLER	xi
ŞEKİL LİSTESİ	xiii
ÇİZELGE LİSTESİ	xv
KISALTMALAR	xvii
SEMBOL LİSTESİ	xix
1.	GİRİŞ	1
1.1	Başlık	1
1.2	Başlık	1
1.2.1	Alt Başlık	1
1.3	Başlık	2
1.4	Başlık	2
1.4.1	Ortam Sıcaklığının Parçacık Morfolojisine Etkisi	2
1.5	Çalışmanın Amacı	2
2.	MATERYALLER VE METOTLAR	3
2.1	Malzemeler	3
2.2	Metodlar	3
2.2.1	Alt Başlık	3
2.2.2	Alt Başlık	3
3.	BULGULAR	5
3.1	Başlık	5
3.1.1	Alt Başlık	5
3.1.2	Alt Başlık	5
3.2	Başlık	5
3.2.1	Alt Başlık	5
3.2.2	Alt Başlık	5
4.	TARTIŞMA	7
4.1	Başlık	7
4.1.1	Alt Başlık	7
4.1.2	Alt Başlık	7
4.2	Başlık	7
4.2.1	Alt Başlık	7
4.2.2	Alt Başlık	7
5.	SONUÇ	9
KAYNAKLAR	11

xi




ÇİZELGE/TABLO/RESİM EKLEMEK İÇİN AŞAĞIDAKİ ADIMLARI TAKİP EDEBİLİRSİNİZ: 
Başlıkların (Caption) Oluşturulması ve Otomatik Numaralandırma
Amaç: Tüm şekil/çizelge/tabloların Word tarafından otomatik numaralandırılması ve listelerde kullanılabilir hale getirilmesi.
1. Başlık verilecek nesneyi seçin.
2. Başvurular (References) → Başlık Ekle (Insert Caption) komutunu açın.
3. Etiket (Label) bölümünden uygun türü seçin:
· “Şekil” veya “Resim” (figure/image)
· “Tablo” yerine “Çizelge” kullanacaksanız Yeni Etiket (New Label) deyip “Çizelge” yazın ve kaydedin.
4. Konum (Position):
· Tablo/Çizelge başlığı üste,
· Şekil/Resim başlığı alta yerleştirilmelidir.
5. Numaralandırma (Numbering):
· Gerekliyse Bölüm numarasını içersin (Include chapter number) seçeneğini işaretleyin. Bölüm başlıklarınızın Başlık 1 (Heading 1) stiliyle tanımlı olduğundan emin olun. Ayırıcı (ör. “1.1”) ve sayı biçimini seçin.
6. Tamam (OK) ile başlığı ekleyin. Başlık biçimini (yazı tipi, punto) gerekirse stil üzerinden düzenleyin; elle numara yazmayın.
Metin İçinde Atıf (Cross-Reference) Yapılması
Amaç: Metin içinde “Bkz. Şekil 3.2” gibi otomatik güncellenen referans eklemek.
1. Atfı eklemek istediğiniz cümlede imleci konumlandırın.
2. Başvurular (References) → Başvuru Ekle (Cross-reference) komutunu açın.
3. Başvurulan öğe türü (Reference type) → Başlık (Caption) seçin.
4. Başvurulan öge (For which caption) listesinden ilgili Şekil/Çizelge’yi seçin.
5. Eklenecek içerik (Insert reference to) bölümünde ihtiyacınıza göre:
· Yalnızca etiket ve numara (örn. “Şekil 3.2”),
· Yalnızca numara,
· Başlığın tamamı,
· Sayfa numarası seçeneklerinden birini seçin.
6. Köprü olarak ekle (Insert as hyperlink) işaretli kalsın (okuyucu tıklayınca ilgili ögeye gider).
7. Ekle (Insert) → Kapat (Close).
Şekil/Tablo/Çizelge Listelerinin Oluşturulması
Amaç: “Şekil Listesi”, “Çizelge Listesi” vb. dizin sayfaları üretmek.
1. Listenin yer alacağı sayfaya gidin ve imleci yerleştirin.
2. Başvurular (References) → Şekil Dizini Ekle (Insert Table of Figures) komutunu açın.
3. Başlık etiketi (Caption label) bölümünden Şekil seçerek Şekil Listesi oluşturun.
· Tab leader (Noktalı lider), Sayfa numaralarını göster ve Sağa hizala seçeneklerini isteğe göre ayarlayın.
4. Tamam (OK).
5. Aynı işlemi yeniden açıp bu kez Çizelge (veya Tablo) etiketini seçerek Çizelge Listesi oluşturun.
6. Listeyi güncellemek için listeye sağ tıklayın → Alanı Güncelle (Update Field) →
· Yalnızca sayfa numaralarını güncelle veya
· Tümünü güncelle seçeneklerinden uygun olanı seçin.
Alanların ve Numaraların Toplu Güncellenmesi
· Belgeyi sonlandırmadan önce: Ctrl+A → F9 (Mac: Cmd+A → Fn+F9 veya sağ tık Alanı Güncelle).
· Bu işlem tüm atıfları, şekil/çizelge numaralarını ve listeleri senkronize eder.






[bookmark: _Toc207281089]ŞEKİL LİSTESİ
Sayfa
Şekil 1.1: XXXXXXXXXXXXXXXXX (Hui vd., 2009).	1
Şekil 1.2: XXXXXXXXXXXXXXXXXX XXXXXXXXXXX XXXXXXX XXX XXXXXXXXX XXXXXXXXXXXXXXXXXX XXXXXX XXXXXXXXXX XXXXXXX XXXXXXXXXXXXXXXXXXXXX XXXXXXXXXX XXXXXXX XXXX XXXXXXX (URL-1).	2
Bir satırı aşan isimlendirmelerde devam eden satırların hizalaması bu sayfada gösterildiği şekilde ilk satırla aynı şekilde yapılmalıdır.
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[bookmark: _Toc207281090]ÇİZELGE LİSTESİ
Sayfa
No table of figures entries found.

Şekil listesi ile aynı formatta hazırlanmalıdır.
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[bookmark: _Toc207281091]KISALTMALAR
SEM		 : Taramalı elektron mikroskopisi
SD		 : Standart Sapma
TEM		 : Transmisyon elektron mikroskobu
……..



Kısaltma koyu (bold), açıklama normal yazılmalıdır. Alfabetik sırada verilmelidir.
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[bookmark: _Toc207281092]SEMBOL LİSTESİ
Bu çalışmada kullanılmış olan simgeler açıklamaları ile birlikte aşağıda sunulmuştur.
Simgeler		Açıklama	
C			Santigrat derece	
mL			Mililitre
………



xxiv




RESİM LİSTESİ
Sayfa
No table of figures entries found.


Şekil listesi ile aynı formatta hazırlanmalıdır.


xxi









[bookmark: _Toc190755316][bookmark: _Toc190755894][bookmark: _Toc224357594][bookmark: _Toc286759111][bookmark: _Toc207281093]GİRİŞ (Bu bölüm 1.sayfadan başalmalıdır.)
Çalışmanın amacı, önemi ve kapsamı açıklanmalıdır. Konuya ilişkin literatür bilgisi verilerek mevcut durum özetlenmeli ve araştırmanın gerekçesi ortaya konulmalıdır. 
Verilen şekil, çizelge, resim, tablo veya denklem gibi tüm unsurlar, kullanılmadan önce mutlaka metin içinde atıf yapılarak sunulmalıdır.
[bookmark: _Toc207281094]Başlık
Alt başlık verilecekse, tek bir alt başlık olmamalı. (Örneğin “1. GİRİŞ” başlığı altında en az 2 adet alt başlık olmalı, aksi takdirde alt başlık eklenmemelidir.) XXXXXXXXXX. 
[bookmark: _Toc207281095]Başlık
Alt başlık verilecekse, tek bir alt başlık olmamalı. (Örneğin “1. GİRİŞ” başlığı altında en az 2 adet alt başlık olmalı, aksi takdirde alt başlık eklenmemelidir.) Tasarlanan mekanizmanın şematik gösterimi Şekil 1.1’de sunulmuştur. (Wang vd., 2015).
[image: ] 
[bookmark: _Toc207280505]Şekil 1.1: Önerilen modelin çalışma prensibini gösteren şematik diyagram  (Hui vd., 2009). (Referanslar cümle sonunda bu şekilde veya numaralı olarak da verilebilir. Kaynak kısmında, numaralı olarak verilen kaynaklar numara sırasına göre, numaralı verilmeyen kaynaklar ise alfabetik olarak listelenmelidir.)
[bookmark: _Toc207281096]Alt Başlık
Alt başlık verilecekse, tek bir alt başlık olmamalı. (Örneğin “1. GİRİŞ” başlığı altında en az 2 adet alt başlık olmalı, aksi takdirde alt başlık eklenmemelidir.) Geliştirilen modelin şematik gösterimi Şekil 1.2’de sunulmaktadır.
[image: ]
[bookmark: _Toc207280506]Şekil 1.2: Sistem bileşenlerinin karşılaştırmalı gösterimi: (a) giriş birimi, (b) işlem birimi, (c) çıkış birimi (URL-1).  (Şekil ismi 1 satırdan uzunsa hizalama buradaki gibi yapılmalıdır.) (Şekilde birdan fazla şekil varsa (a),(b),(c),.. şeklinde numaralandırılmalı ve hepsiaçıklamasıyla verilmelidir.)
[bookmark: _Toc207281097]Başlık
Alt başlık verilecekse, tek bir alt başlık olmamalı. (Örneğin “1. GİRİŞ” başlığı altında en az 2 adet alt başlık olmalı, aksi takdirde alt başlık eklenmemelidir.) XXXXXXXXXXXXXXXXXX. 
[bookmark: _Toc207281098]Başlık
XXXXXXXXXXXXXXXXXX 
[bookmark: _Toc207281099]Ortam Sıcaklığının Parçacık Morfolojisine Etkisi
XXXXXXXXXXXXXXXXXX 
[bookmark: _Toc207281100]Çalışmanın Amacı
XXXXXXXXXXXXXXXXXXXX.


[bookmark: _Toc207281101]MATERYALLER VE METOTLAR (Her 1.derece bölüm başlığı yeni bir tek numaralı sayfadan başlatılmalıdır. Başlıklar BÜYÜK HARFLER ile yazılmalıdır.
Araştırmada kullanılan materyaller tanıtılmalı ve uygulanan yöntemler ayrıntılı, açık ve tekrarlanabilir biçimde açıklanmalıdır. 
Verilen şekil, çizelge, resim, tablo veya denklem gibi tüm unsurlar, kullanılmadan önce mutlaka metin içinde atıf yapılarak sunulmalıdır.
[bookmark: _Toc207281102]Malzemeler
Bu çalışmada kullanılan malzemeler, özellikleri ve temin edildikleri kaynaklar aşağıda sunulmuştur. Kullanılan tüm materyaller açık ve anlaşılır şekilde tanımlanmalıdır.
[bookmark: _Toc207281103]Metodlar
Araştırma kapsamında uygulanan yöntemler bu bölümde ayrıntılı olarak açıklanmıştır. Yöntemler, çalışmanın tekrarlanabilirliğini sağlayacak şekilde açık ve sistematik olarak sunulmalıdır.
[bookmark: _Toc207281104]Alt Başlık
Bu alt bölümde, ilgili yönteme ait uygulama adımları detaylı olarak açıklanmalıdır. Deneysel veya analitik süreçler açık, anlaşılır ve kronolojik sıraya uygun şekilde verilmelidir.
[bookmark: _Toc207281105]Alt Başlık
Bu alt bölümde, kullanılan diğer yöntem veya analiz teknikleri açıklanmalıdır. Gerekli durumlarda parametreler, koşullar ve kullanılan cihazlara ilişkin bilgiler belirtilmelidir. .........
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Çift numaralı sayfalar boş bırakıldığında, bu sayfalara sayfa numarası verilmemelidir. Bu uygulamanın sağlanabilmesi için aşağıdaki basamaklar izlenmelidir:
Section Break (Bölüm Sonu) Kullanarak
1. Gizlemek istediğin sayfanın öncesine git
2. Layout (Düzen) sekmesinden Breaks (Sonlandırmalar)
3. Next Page (Sonraki Sayfa) seç.
4. Gizlemek istediğin sayfanın sonuna git 
5. Tekrar aynı şekilde Next Page Section Break ekle.
(Böylece o sayfa tek başına bir bölüm olur.)
6. O sayfadayken üst/alt bilgi alanına çift tıkla.
7. Header & Footer Tools → Link to Previous seçeneğinin işaretini kaldır.
8. Sadece o bölümdeki sayfa numarasını sil.
Böylece sadece o sayfada görünmez, diğer sayfalarda numaralandırma devam eder.





[bookmark: _Toc207281106]BULGULAR
Araştırmadan elde edilen veriler, tablo, şekil ve grafikler eşliğinde nesnel olarak sunulmalıdır. Yorum yapılmamalı, yalnızca sonuçlar verilmelidir. 
Verilen şekil, çizelge, resim, tablo veya denklem gibi tüm unsurlar, kullanılmadan önce mutlaka metin içinde atıf yapılarak sunulmalıdır.
[bookmark: _Toc207281107]Başlık
[bookmark: _Toc207281108]Alt Başlık
Belirlenen parametreler ve bu parametrelere karşılık gelen çıktılar Çizelge 3.1’de sunulmuştur.
Çizelge 3.1: Örnek bir mühendislik uygulamasına ait parametrelerin ve değerlerin gösterimi. (Çizelge ismi veirldikten sonra cümle sonuna nokta mutlaka konulmalıdır.Çizelge içerisinde kolonlar içerisindekli metinler de ortalanmış olmalıdır, yazı tipi Times New Roman ve 10-12 punto arası olmalıdır.)
[image: ]
[bookmark: _Toc207281109]Alt Başlık
Bu alt başlık altında elde edilen diğer bulgular sunulmalıdır.
[bookmark: _Toc207281110]Başlık
[bookmark: _Toc207281111]Alt Başlık
İlgili veriler ve karşılaştırmalı sonuçlar Çizelge 3.2’de verilmiştir.
Çizelge 3.2: Örnek bir veri setine ait sonuçların karşılaştırılması.
[image: ]
[bookmark: _Toc207281112]Alt Başlık
Analizlerde kullanılan matematiksel model Eşitlik (3.1) ile ifade edilmiştir. (Eşitlikler sayfa ortasında verilmelidir. Denklem numarası sağa yaslı olmalıdır. Denklemde yer alan tüm parametreler metin içerisinde açıklanmalıdır.)
	   	           (3.1)
.......

ÖNEMLİ NOT: Bulgular bölümü yalnızca elde edilen verilerin nesnel sunumunu içermelidir; yorum ve tartışmaya yer verilmemelidir. Tüm şekil, çizelge ve denklemler metin içerisinde atıf yapıldıktan sonra verilmelidir. Denklemler ortalı, numaraları sağa yaslı olacak şekilde düzenlenmeli ve tüm parametreler açıklanmalıdır.
Alt başlık verilecekse, tek bir alt başlık olmamalı. (Örneğin “1. GİRİŞ” başlığı altında en az 2 adet alt başlık olmalı, aksi takdirde alt başlık eklenmemelidir.)
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[bookmark: _Toc207281113]TARTIŞMA
Bu bölümde, elde edilen bulgular literatürde yer alan çalışmalar ile karşılaştırılarak değerlendirilmelidir. Bulguların bilimsel anlamı ortaya konulmalı, çalışmanın güçlü yönleri ve kısıtlılıkları tartışılmalıdır. Ayrıca çalışmanın literatüre olan katkısı açık bir şekilde ifade edilmelidir.
Verilen şekil, çizelge, resim, tablo veya denklem gibi tüm unsurlar, kullanılmadan önce mutlaka metin içinde atıf yapılarak sunulmalıdır.
[bookmark: _Toc207281114]Başlık (TÜM KELİMELERİN İLK HARFLERİ BÜYÜK,)
[bookmark: _Toc207281115]Alt Başlık (SADECE İLK HARF BÜYÜK)
Elde edilen bulgular, benzer çalışmalar ile karşılaştırıldığında önerilen yaklaşımın performans açısından avantaj sağladığı görülmektedir. Bu durum, literatürde bildirilen sonuçlar ile uyumluluk göstermektedir.
[bookmark: _Toc207281116]Alt Başlık
Sonuçlar, sistem performansının belirli parametrelere duyarlı olduğunu göstermektedir. Bu bulgu, önceki çalışmalarla paralellik göstermekte olup yöntemin geçerliliğini desteklemektedir.
[bookmark: _Toc207281117]Başlık
[bookmark: _Toc161927814][bookmark: _Toc207281118]Alt Başlık
Çalışmada elde edilen bulgular, mevcut yöntemlere kıyasla iyileştirilmiş sonuçlar sunmaktadır. Bununla birlikte, bazı sınırlılıklar göz önünde bulundurulmalıdır.
114






[bookmark: _Toc207281120]SONUÇ
Çalışmanın genel sonuçları açık ve öz bir biçimde ifade edilmeli, araştırmanın katkısı ve varsa öneriler belirtilmelidir. 
Verilen şekil, çizelge, resim, tablo veya denklem gibi tüm unsurlar, kullanılmadan önce mutlaka metin içinde atıf yapılarak sunulmalıdır. 
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[bookmark: _Toc207281121][bookmark: _Toc286759146]KAYNAKLAR
ÖNEMLİ NOT: Kaynak formatı (alfabetik sıra veya sayı ile verme) danışmanın görüşü ile belirlenebilir. Ayrıca, aşağıdaki kurallara dikkat edilmelidir:
Dikkat edilmesi gereken noktalar:
· Yazar isimleri bold (kalın) olmalı.
· Makale başlığı normal yazılmalı.
· Dergi adı italik, cilt italik, sayı parantez içinde normal, sayfa numaraları normal olmalı.
· Noktalama işaretleri APA kurallarına uygun olmalı.
1 SATIDAN UZUN KAYNAKLARDA İKİNCİ VE SONRASI SATIRLAR, İLK YAZARIN SOYADINDAN SONRAKİ İLK HARFE DENK GELECEK ŞEKİLDE HİZALANMALIDIR.
ALFABETİK SIRA İLE VERİLİYORSA KAYNAĞA METİN İÇİNDE ATIF (İlk Yazar Soyadı vd., Yıl) (Ör: Liu vd., 2019) ŞEKLİNDE YAPILIR. KAYNAKLAR BÖLÜMÜNDE İSE İLK YAZAR SOYADINA GÖRE ALFABETİK OLARAK ŞU ŞEKİLDE LİSTELENMELİDİR:
YazarSoyadı, A. A., & YazarSoyadı, B. B. (Yıl). Makale başlığı. Dergi Adı, cilt(sayı), sayfa aralığı.
YazarSoyadı, A. A., & YazarSoyadı, B. B., YazarSoyadı, C. C. (Yıl). Makale başlığı. Dergi Adı, cilt(sayı), sayfa aralığı.
........................
SAYI İLE VERİLİYORSA KAYNAĞA METİN İÇİNDE ATIF [SAYI] (Ör: [1]) ŞEKLİNDE YAPILIR VE TEZİN EN BAŞINDAN ATIFLAR [1]’DEN BAŞLAYARAK ARTARAK İLERLER. KAYNAKLAR BÖLÜMÜNDE AŞAĞIDAKİ GİBİ METİN İÇİNDE ATIF YAPILAN SAYILARLA KAYNAKLAR LİSTELENMELİDİR (ALFABETİK SIRA KULLANILMAZ, METİN İÇİNDEKİ ATIF NUMARASI SIRASI KULLANILIR):
[1] YazarSoyadı, A. A., & YazarSoyadı, B. B. (Yıl). Makale başlığı. Dergi Adı, cilt(sayı), sayfa aralığı.
[2] YazarSoyadı, A. A., & YazarSoyadı, B. B. (Yıl). Makale başlığı. Dergi Adı, cilt(sayı), sayfa aralığı.
........................

İNTERNET ADRESİ ÜZERİNDEN KAYNAK VERİLECEKSE AŞAĞIDAKİ FORMAT KULLANILMALIDIR (APA-7 FORMATI ÖRNEK ALINABİLİR). BUNLARA METİN İÇİNDE ATIFLAR [URL-1] ŞEKLİNDE YAPILABİLİR. 
URL-1: (Varsa) Yazar Soyadı, A. A., (Varsa) (Yıl), İnternet Sitesindeki Başlık (Article Title), Web adresi , Erişim tarihi:01.01.2020.
URL-2: (Varsa) Yazar Soyadı, A. A., (Varsa) (Yıl), İnternet Sitesindeki Başlık (Article Title), Web adresi , Erişim tarihi:01.01.2020.
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EKLER
EK 1: Sabitler ve Dönüştürme Faktörleri
EK 2: Fiziksel Faktörler
.....



ÖZGEÇMİŞ

Ad-Soyad			: XXXXXXXX
Uyruğu			: XXXXXXXX
Doğum Tarihi ve Yeri	: 01/01/1990 ŞEHİR
E-posta			: XXXXXXXX

ÖĞRENİM DURUMU
· Lisans		: Mezuniyet Yılı(rakam ile), Üniversite İsmi, Fakülte İsmi, Bölüm İsmi
· Yüksek Lisans	: Mezuniyet Yılı(rakam ile), Üniversite İsmi, Fakülte İsmi, Bölüm İsmi (BURASI DOKTORA TEZİ YAZANLAR İÇİN BELİRTİLMELİDİR.)
MESLEKİ DENEYİM VE ÖDÜLLER
Ay(yazı) Yıl(rakam)		Firma ismi
Unvan
YABANCI DİL:
· Dilin ismi	: Başlangıç/Orta/İleri seviye
TEZDEN TÜRETİLEN YAYINLAR, SUNUMLAR VE PATENTLER:
· APA formatta verilmelidir, kendi isminizin geçtiği kısım “kalın(bold)” olarak yazılmalıdır.
DİĞER YAYINLAR, SUNUMLAR VE PATENTLER:
· APA formatta verilmelidir, kendi isminizin geçtiği kısım “kalın(bold)” olarak yazılmalıdır
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